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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP 2133 Mini-Note PC

Processors VIA Technology C7-M Ultra Low Voltage (ULV) processors

 ● VIA C7-M ULV 1.6-GHz processor, 800-MHz front-side bus (FSB), 8-W thermal design power (TDP)

 ● VIA C7-M ULV 1.2-GHz processor, 800-MHz FSB, 5-W TDP

 ● VIA C7-M ULV 1.0-GHz processor, 400-MHz FSB, 3.5-W TDP

Chipset Northbridge: VIA CN896

 Southbridge: VIA 8237s

Graphics VIA Universal Memory Architecture (UMA) graphics subsystem

Panels All display assemblies include 2 microphones, 2 speakers, and 2 WLAN antenna transceivers and cables

 ● 8.9-inch WXGA (1280 × 768) with camera

 ● 8.9-inch WXGA (1280 × 768) without camera

 ● 8.9-inch WSVGA (1024 × 600) with camera

 ● 8.9-inch WSVGA (1024 × 600) without camera

Memory One customer-accessible/upgradable memory module slot

 Supports up to 2 GB of system RAM

 PC2-5300, 667-MHz, DDR2

 Supports the following configurations:

● 2048-MB total system memory (2048 × 1)

● 1024-MB total system memory (1024 × 1)

● 512-MB total system memory (512 × 1)

Mass storage
device

Supports 9.5-mm (2.5-inch) serial ATA (SATA) hard drives

 Supports the following SATA hard drives:

● 160-GB, 7200-rpm

● 160-GB, 5400-rpm

● 120-GB, 7200-rpm

● 120-GB, 5400-rpm
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Category Description

 80-GB solid state drive

 Supports 9.5-mm (2.5-inch) SATA 4-GB flash storage drive

Optical drive Supports external USB optical drive only

Diskette drive Supports external USB diskette drive only

Audio HD audio - AD1984

 Stereo speakers (2)

 Intergrated stereo microphones (2)

Webcam Optional integrated VGA webcam

Modem Supports external USB modem only

Ethernet Broadcom 5788 10/100/1000 LAN

 S3/S4/S5 wake on LAN: DC - no

 S3/S4/S5 wake on LAN: AC - yes

Wireless Integrated WLAN options by way of wireless module:

 2 WLAN antennae built into display assembly

 Support for no-WLAN option

 Support for the following WLAN formats:

● Broadcom 4311AG 802.11a/b/g WLAN module

● Broadcom BCM4312 802.11b/g WLAN module

 Integrated personal area network (PAN) options by way of Bluetooth® module:

 Support for no-WPAN option

 Broadcom Bluetooth 2.0+EDR

External media
card

One ExpressCard/54 slot

 SD/MMC Card Reader supporting Secure Digital (SD) Memory Card and MultiMediaCard (MMC)

Ports Audio-in (stereo microphone)

 Audio-out (stereo headphone)

 RJ-45 (Ethernet, includes link and activity lights)

 USB (non-powered)

 USB (powered)

 VGA (Dsub 15-pin) supporting 1920 × 1440 external resolution at 75-GHz (hot plug/unplug with auto-detect)

 2-pin AC power

Keyboard/
pointing
devices

25.4-cm (10.0-inch) keyboard with embedded numeric keypad

 Windows Vista® Start button
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Category Description

 TouchPad, with 2 TouchPad buttons and vertical scrolling (taps enabled as default)

Power
requirements

65-W AC adapter with localized cable plug support (3-wire plug, supports 2-pin DC connector)

 6-cell, 55-Wh Li-ion battery

 3-cell, 28-Wh Li-ion battery

Security Supports Kensington security lock

 HP 3D DriveGuard

Operating
system

Preinstalled:

 Windows Vista® Basic 32 with Office 2007 Ready

 Windows Vista Business 32 with Office 2007 Ready

 Windows® XP Professional

 Windows XP Home

 SUSE Linux Enterprise Desktop

 Restore media:

 DR DVD Windows Vista Home Basic

 OS DVD Windows Vista Business

 DR DVD/OS DVD Windows XP Pro

 SUSE Linux Enterprise Desktop

Serviceability End-user replaceable parts:

 AC adapter

 Battery (system)

 Hard drive

 Memory module
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2 External component identification

Top components
Display

Item Component Function

(1) Speakers (2) Produce sound.

(2) Wireless antennae (2) Send and receive signals from one or more wireless
devices.

NOTE: The antennae are not visible from the outside of
the computer.

(3) Internal microphones (2) Record sound.

NOTE: If there is a microphone icon next to each
microphone opening, your computer has internal
microphones.

(4) Webcam (select models only) ● Records and plays back webcam video.

● Includes streaming video options and special effects
for adding frames, filters, and emoticons to
snapshots and video.
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Item Component Function

● Captures single frame or burst webcam snapshots.

● Connects to e-mail photos and video.

Keys

Item Component Function

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed
in combination with the fn key.
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TouchPad

Item Component Function

(1) TouchPad on/off button Enables/disables the TouchPad.

(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) TouchPad* Moves the pointer and selects or activates items on the
screen.

(4) TouchPad scroll zone Scrolls up or down.

(5) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences, select Start > Control Panel > Hardware
and Sound > Mouse.
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Front components

Item Component Function

(1) Power light ● Blue: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(2) Power switch ● When the computer is off, slide the switch to turn on
the computer.

● When the computer is on, slide the switch briefly to
initiate Hibernation.

● When the computer is in the Sleep state, slide the
switch briefly to exit Sleep.

● When the computer is in Hibernation, slide the switch
briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, slide and hold the
power switch for at least 5 seconds to turn off the
computer.

To learn more about your power settings, select Start >
Control Panel > System and Maintenance > Power
Options.

(3) Drive light Blinking: The hard drive is being accessed.

(4) Wireless light ● Blue: An integrated wireless device, such as a
wireless local area network (WLAN) device, the HP
Broadband Wireless Module, and/or a Bluetooth®
device, is on.

● Amber: All wireless devices are off.

NOTE: The wireless light turns amber when the
computer turns on, but all wireless devices are off.

(5) Wireless switch Turns the wireless feature on or off, but does not create a
wireless connection.

NOTE: To establish a wireless connection, a wireless
network must already be set up.
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Right-side components

Item Component Function

(1) ExpressCard slot Supports optional ExpressCards 54.

(2) SD Card Reader Supports the following optional digital card formats:

● Secure Digital (SD) Memory Card

● MultiMediaCard (MMC)

(3) USB port Connects an optional USB device.

(4) RJ-45 (network) jack Connects a network cable.

(5) Battery light ● Amber: A battery is charging.

● Blue: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level.

● If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

(6) Power connector Connects an AC adapter.

(7) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Left-side components

Item Component Function

(1) External monitor port Connects an external VGA monitor or projector.

(2) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(3) Powered USB port Provides power to a USB device, such as an optional
external MultiBay or an optional external optical drive, if
used with a powered USB cable.

(4) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(5) Audio-out (headphone) jack Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.
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Bottom components

Item Component Function

(1) Battery release latches (2) Release the battery from the battery bay.

(2) Battery bay Holds the battery.

(3) Service tag Provides the product brand and series name, serial number
(s/n), and product number (p/n) of your computer. Have this
information available when you contact technical support.

(4) Vents (3) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.
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Wireless antennae (select models only)
On select computer models, at least 2 antennae send and receive signals from one or more wireless
devices. These antennae are not visible from the outside of the computer.

NOTE: For optimal transmission, keep the areas immediately around the antennae free from
obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.

Wireless antennae (select models only) 11



3 Illustrated parts catalog

Serial number location
When ordering parts or requesting information, provide the computer serial number and model number
located on the bottom of the computer.
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Computer major components

Item Description Spare part number

(1) 8.9-inch, WXGA display assemblies (include 2 microphones, 2 speakers, and 2 WLAN antenna transceivers and
cables)

 For use only with computer models equipped with camera module 483384-001

 For use only with computer models not equipped camera module 482278-001
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Item Description Spare part number

 8.9-inch, WSVGA display assemblies (include 2 microphones, 2 speakers, and 2 WLAN
antenna transceivers and cables)

 

 For use only with computer models equipped with camera module and system boards with the
following spare part numbers: 498308-001, 500754-001, and 500755-001

498309-001

 For use only with computer models not equipped with camera module and system boards with
the following spare part numbers: 498308-001, 500754-001, and 500755-001

500459-001

(2) Keyboards

 For use in Brazil 482280-201

 For use in the Czech Republic 482280-221

 For use in Denmark 482280-081

 For use in Europe 482280-181

 For use in France 482280-051

 For use in French Canada 482280-121

 For use in Germany 482280-041

 For use in Greece 482280-DJ1

 For use in Hungary 482280-211

 For use in Iceland 482280-DD1

 For use internationally 482280-B31

 For use in Israel 482280-BB1

 For use in Italy 482280-061

 For use in Japan 482280-291

 For use in Latin America 482280-161

 For use in Norway 482280-091

 For use in Portugal 482280-131

 For use in Saudi Arabia 482280-171

 For use in Slovakia 482280-231

 For use in Slovenia 482280-BA1

 For use in South Korea 482280-AD1

 For use in Spain 482280-071

 For use in Sweden and Finland 482280-B71

 For use in Switzerland 482280-BG1

 For use in Taiwan 482280-AB1

 For use in Thailand 482280-281

 For use in the United Kingdom 482280-031

 For use in the United States 482280-001
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Item Description Spare part number

(3) Memory modules (PC2-5300, 667-MHz, DDR2)

 2048-MB 417506-001

 1024-MB 414046-001

 512-MB 414045-001

(4) Mass storage devices

 Hard drives (include bracket and SATA connector)

 160-GB, 7200-rpm 482271-001

 160-GB, 5400-rpm 482269-001

 120-GB, 7200-rpm 482268-001

 120-GB, 5400-rpm 482267-001

 80-GB solid-state drive (includes bracket and SATA connector) 502600-001

 4-GB solid-state drive (includes bracket and SATA connector) 482272-001

(5) Top cover (includes power on switch board and cable, TouchPad board and cable, and
wireless on/off switch board and cable)

482265-001

(6) Audio board 505907-001

 For use only in computer models with WXGA displays 482274-001

(7) Fan/heat sink (includes replacement thermal material) 482279-001

 Bracket Kit (see Bracket Kit on page 18 for more Bracket Kit spare part number
information)

482266-001

(8a) Audio/USB connector bracket

(8b) ExpressCard assembly bracket

(8c) USB/RJ-45 connector bracket

 Plastics/Cable Kit (see Plastics/Cable Kit on page 19 for more Plastics/Cable Kit spare part
number information)

483381-001

(9a) ExpressCard slot bezel

(9b) SD Card slot bezel

(9c) Bluetooth module cable

(10) Broadcom Bluetooth modules (embedded)

NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth module cable
is included in the Plastics/Cable Kit, spare part number 483381-001. See Plastics/Cable Kit on page 19 for more
Plastics/Cable Kit spare part number information.

 For use in all countries and regions except Japan and Asia Pacific countries and regions 398393-002

 For use only in Japan and Asia Pacific countries and regions 450066-001

(11) System boards (include ExpressCard assembly, fan/heat sink, processor, RTC battery, and replacement thermal
material)

 Equipped with 1.6-GHz processor and only for use with WXGA displays 482277-001

 Equipped with 1.2-GHz processor and only for use with WXGA displays 482276-001
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Item Description Spare part number

 Equipped with 1.0-GHz processor and only for use with WXGA displays 482275-001

 Equipped with 1.6-GHz processor 500755-001

 Equipped with 1.2-GHz processor 498308-001

 Equipped with 1.0-GHz processor 500754-001

(12) RTC battery 449137-001

(13) WLAN modules

 Broadcom 4311AG 802.11a/b/g WLAN modules:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

441075-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland,
Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan,
Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia,
St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-002

 ● For use in Japan 441075-291

 Broadcom BCM4312 802.11b/g WLAN modules:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

459263-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland,
Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan,
Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,

459263-002
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Item Description Spare part number

Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia,
St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

(14) Base enclosure (includes 4 rubber feet) 482264-001

 Rubber Kit (not illustrated, contains 4 computer feet) 483382-001

(15) Batteries

 6-cell, 55-Wh Li-ion battery 482263-001

 3-cell, 28-Wh Li-ion battery 482262-001
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Bracket Kit

Item Description Spare part number

 Bracket Kit: 482266-001

(1) ExpressCard assembly bracket

(2) USB/RJ-45 connector bracket

(3) Audio/USB connector bracket
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Plastics/Cable Kit

Item Description Spare part number

 Plastics/Cable Kit: 483381-001

(1) ExpressCard slot bezel

(2) SD Card slot bezel

(3) Bluetooth module cable

Miscellaneous parts
Description Spare part number

65-W HP Smart AC adapter 463958-001

Power cords:

For use in Australia 246959-011

For use in Brazil 246959-201

For use in Denmark 246959-081

For use in Europe, the Middle East, and Africa 246959-021

For use in Israel 246959-BB1

For use in Italy 246959-061

For use in Japan 246959-291

For use in South Korea 246959-AD1

For use in Switzerland 246959-AG1

For use in Taiwan 394279-AB1

For use in the United Kingdom 246959-031
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Description Spare part number

For use the United States 246959-001

Screw Kit

● Phillips PM2.0×3.0 screw

● Torx8 T8M2.5×10.0 screw

● Torx8 T8M2.5×5.0 screw

● Torx8 T8M2.0×6.0 screw

● Torx8 T8M2.0×4.0 screw

483383-001

Sequential part number listing
Spare part
number

Description

246959-001 Power cord for use in the United States

246959-011 Power cord for use in Australia and New Zealand

246959-021 Power cord for use in Europe, the Middle East, and Africa

246959-031 Power cord for use in the United Kingdom

246959-061 Power cord for use in Italy

246959-081 Power cord for use in Denmark

246959-201 Power cord for use in Brazil

246959-291 Power cord for use in Japan

246959-AD1 Power cord for use in South Korea

246959-AG1 Power cord for use in Switzerland

246959-BB1 Power cord for use in Israel

394279-AB1 Power cord for use in Taiwan

398393-002 Bluetooth module for use in all countries and regions except Japan and Asia Pacific countries and regions

NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth module
cable is included in the Plastics/Cable Kit, spare part number 483381-001. See Plastics/Cable Kit
on page 19 for more Plastics/Cable Kit spare part number information.

414045-001 512-MB memory module (PC2-5300, 667-MHz, DDR2)

414046-001 1024-MB memory module (PC2-5300, 667-MHz, DDR2)

417506-001 2048-MB memory module (PC2-5300, 667-MHz, DDR2)

441075-001 Broadcom 4311AG 802.11a/b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico,
the U.S. Virgin Islands, and the United States

441075-002 Broadcom 4311AG 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,

20 Chapter 3   Illustrated parts catalog



Spare part
number

Description

Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic,
East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland,
Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia,
Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain,
Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-291 Broadcom 4311AG 802.11a/b/g WLAN module for use in Japan

449137-001 RTC battery

450066-001 Bluetooth module for use only in Japan and Asia Pacific countries and regions

NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth module
cable is included in the Plastics/Cable Kit, spare part number 483381-001. See Plastics/Cable Kit
on page 19 for more Plastics/Cable Kit spare part number information.

459263-001 Broadcom BCM4312 802.11b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico,
the U.S. Virgin Islands, and the United States

459263-002 Broadcom BCM4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic,
East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland,
Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia,
Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain,
Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

463958-001 65-W HP Smart AC adapter

482262-001 3-cell, 28-Wh Li-ion battery

482263-001 6-cell, 55-Wh Li-ion battery

482264-001 Base enclosure (includes 4 rubber feet)

482265-001 Top cover (includes power on switch board and cable, TouchPad board and cable, and wireless on/off switch
board and cable)
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Spare part
number

Description

482266-001 Bracket Kit (see Bracket Kit on page 18 for more Bracket Kit spare part number information)

482267-001 120-GB, 5400-rpm hard drive (includes bracket and SATA connector)

482268-001 120-GB, 7200-rpm hard drive (includes bracket and SATA connector)

482269-001 160-GB, 5400-rpm hard drive (includes bracket and SATA connector)

482271-001 160-GB, 7200-rpm hard drive (includes bracket and SATA connector)

482272-001 4-GB solid-state drive (includes bracket and SATA connector)

482274-001 Audio board for use only in computer models with WXGA displays

482275-001 System board equipped with 1.0-GHz processor and only for use with WXGA displays (includes ExpressCard
assembly, fan/heat sink, processor, RTC battery, and replacement thermal material)

482276-001 System board equipped with 1.2-GHz processor and only for use with WXGA displays (includes ExpressCard
assembly, fan/heat sink, processor, RTC battery, and replacement thermal material)

482277-001 System board equipped with 1.6-GHz processor and only for use with WXGA displays (includes ExpressCard
assembly, fan/heat sink, processor, RTC battery, and replacement thermal material)

482278-001 8.9-inch, WXGA display assembly for use only with computer models not equipped camera module (includes
2 microphones, 2 speakers, and 2 WLAN antenna transceivers and cables)

482279-001 Fan/heat sink (includes replacement thermal material)

482280-001 Keyboard for use in the United States

482280-031 Keyboard for use in the United Kingdom

482280-041 Keyboard for use in Germany

482280-051 Keyboard for use in France

482280-061 Keyboard for use in Italy

482280-071 Keyboard for use in Spain

482280-081 Keyboard for use in Denmark

482280-091 Keyboard for use in Norway

482280-121 Keyboard for use in French Canada

482280-131 Keyboard for use in Portugal

482280-161 Keyboard for use in Latin America

482280-171 Keyboard for use in Saudi Arabia

482280-181 Keyboard for use in Europe

482280-201 Keyboard for use in Brazil

482280-211 Keyboard for use in Hungary

482280-221 Keyboard for use in Czechoslovakia

482280-231 Keyboard for use in Slovakia

482280-251 Keyboard for use in Russia

482280-281 Keyboard for use in Thailand
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Spare part
number

Description

482280-291 Keyboard for use in Japan

482280-AB1 Keyboard for use in Taiwan

482280-AD1 Keyboard for use in South Korea

482280-B31 Keyboard for use internationally

482280-B71 Keyboard for use in Sweden and Finland

482280-BA1 Keyboard for use in Slovenia

482280-BB1 Keyboard for use in Israel

482280-BG1 Keyboard for use in Switzerland

482280-DD1 Keyboard for use in Iceland

482280-DJ1 Keyboard for use in Greece

483381-001 Plastics/Cable Kit (see Plastics/Cable Kit on page 19 for more Plastics/Cable Kit spare part number
information)

483382-001 Rubber Kit (contains 4 computer feet)

483383-001 Screw Kit

483384-001 8.9-inch, WXGA display assembly for use only with computer models not equipped camera module (includes
2 microphones, 2 speakers, and 2 WLAN antenna transceivers and cables)

498308-001 System board equipped with 1.2-GHz processor (includes ExpressCard assembly, fan/heat sink, processor,
RTC battery, and replacement thermal material)

498309-001 8.9-inch, WSVGA display assembly for use only with computer models equipped with a camera module and
system boards with the following spare part numbers: 498308-001, 500754-001, and 500755-001 (includes 2
microphones, 2 speakers, and 2 WLAN antenna transceivers and cables)

500459-001 8.9-inch, WSVGA display assembly for use only with computer models not equipped with a camera module
and system boards with the following spare part numbers: 498308-001, 500754-001, and 500755-001
(includes 2 microphones, 2 speakers, and 2 WLAN antenna transceivers and cables)

500754-001 System board equipped with 1.0-GHz processor (includes ExpressCard assembly, fan/heat sink, processor,
RTC battery, and replacement thermal material)

500755-001 System board equipped with 1.6-GHz processor (includes ExpressCard assembly, fan/heat sink, processor,
RTC battery, and replacement thermal material)

502600-001 80-GB solid-state drive (includes bracket and SATA connector)

505907-001 Audio board
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx8 T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V

28 Chapter 4   Removal and replacement procedures



Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the
password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 52).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 31 screws, in 5 different sizes, that must be removed or replaced when servicing
the computer. Make special note of each screw size and location during removal and replacement.

Serial number
Report the computer serial number to HP when requesting information or ordering spare parts. The
serial number is located on the bottom of the computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 483382-001. There are 4 rubber feet that are installed on the base enclosure in the locations
illustrated below. The rubber feet are attached to the base enclosure by tethers.
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Battery

Description Spare part number

6-cell, 55-Wh Li-ion battery 482262-001

3-cell, 28-Wh Li-ion battery 482263-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Keyboard

Keyboards for use in the following countries or regions:

Country or region: Spare part number Country or region: Spare part number

Brazil 482280-201 Norway 482280-091

Czechoslovakia 482280-221 Portugal 482280-131

Denmark 482280-081 Russia 482280-251

Europe 482280-181 Saudi Arabia 482280-171

France 482280-051 Slovakia 482280-231

French Canada 482280-121 Slovenia 482280-BA1

Germany 482280-041 South Korea 482280-AD1

Greece 482280-DJ1 Spain 482280-071

Hungary 482280-211 Sweden and Finland 482280-B71

Iceland 482280-DD1 Switzerland 482280-BG1

International 482280-B31 Taiwan 482280-AB1

Israel 482280-BB1 Thailand 482280-281

Italy 482280-061 The United Kingdom 482280-031

Japan 482280-291 The United States 482280-001

Latin America 482280-161   

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).
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Remove the keyboard:

1. Remove the three Phillips PM2.0×3.0 screws that secure the keyboard to the computer.

2. Turn the computer display-side up, with the front toward you.

3. Open the computer as far as possible.

4. Lift the rear edge of the keyboard (1) until it rests at an angle, and then slide it back (2) until it rests
on the display assembly.
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5. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

6. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Memory module

Description Spare part number

2048-MB (PC2-5300, 667-MHz, DDR2) 417506-001

1024-MB (PC2-5300, 667-MHz, DDR2) 414046-001

512-MB (PC2-5300, 667-MHz, DDR2) 414045-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).

5. Remove the keyboard (see Keyboard on page 33).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Mass storage device
NOTE: All hard drive and solid-state drive spare part kits include a bracket and SATA adapter.

Description Spare part number

SATA hard drives:

160-GB, 7200-rpm hard drive 482271-001

160-GB, 5400-rpm hard drive 482269-001

120-GB, 7200-rpm hard drive 482268-001

120-GB, 5400-rpm hard drive 482267-001

80-GB solid state drive 502600-001

4-GB solid state drive 482272-001

Before removing the hard drive or solid-state drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).

5. Remove the keyboard (see Keyboard on page 33).
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Remove the hard drive or solid-state drive:

1. Disconnect the drive cable (1) from the connector on the system board (2).

2. Remove the Phillips PM2.0×5.0 screw (1) and the two PM2.0×5.0 screws (2) that secure the drive
to the computer.

NOTE: The screw highlighted by callout (1) is captive in hard drives, non-captive in solid state
drives.

3. Grasp the Mylar tab (3) on the drive and slide the drive (4) to the left to release it from the drive
bay.

4. Remove the drive (5) from the drive bay.

Reverse this procedure to install the hard drive or solid-state drive.
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Top cover

Description Spare part number

Top cover 482265-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).

5. Remove the keyboard (see Keyboard on page 33).

6. Remove the hard drive or solid-state drive (see Mass storage device on page 37).

Remove the top cover:

1. Turn the computer upside down, with the front toward you.

2. Use a thin, flat tool to release the four rubber feet (1).

CAUTION: The rubber feet are attached to the base enclosure by tethers. Exercise caution when
releasing the rubber feet to prevent damaging the feet.

3. Remove the three Torx8 T8M2.5×10.0 screws (2) and the Torx8 T8M2.0×4.0 screw (3) that secure
the top cover to the base enclosure.

4. Turn the computer right-side up, with the front toward you.

5. Open the computer as far as possible.

6. Remove the Torx8 T8M2.5×10.0 screw (1) that secures the top cover to the base enclosure.
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7. Lift the rear edge of the top cover (2) and swing it up and forward until it rests upside down in front
of the computer.

8. Disconnect the power switch board cable (1) from the system board.

9. Release the ZIF connector (2) to which the TouchPad cable is connected and disconnect the
TouchPad cable (3) from the system board.

10. Disconnect the wireless on/off switch board cable (4) from the system board.

11. Remove the top cover.

Reverse this procedure to install the top cover.
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Audio board

Description Spare part number

Audio board for use only in computer models with WXGA displays 482274-001

Audio board 505907-001

Before removing the audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).

5. Remove the following components:

a. Keyboard (see Keyboard on page 33)

b. Hard drive or solid-state drive (see Mass storage device on page 37)

c. Top cover (see Top cover on page 39)

Remove the audio board:

1. Remove the Torx8 T8M2.0×6.0 screw that secures the audio board to the computer.

2. Lift the audio board (1) to disconnect the audio board connector (2) from the system board.
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3. Disconnect the audio board cables (3) from the audio board.

4. Remove the audio board.

Reverse this procedure to install the audio board.
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Bluetooth module
NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth
module cable is included in the Plastics/Cable Kit, spare part number 483381-001. See Plastics/Cable
Kit on page 19 for more Plastics/Cable Kit spare part number information.

Description Spare part number

For use in all countries and regions except Japan and Asia Pacific countries and regions 398393-002

For use only Japan and Asia Pacific countries and regions 450066-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).

5. Remove the following components:

a. Keyboard (see Keyboard on page 33)

b. Hard drive or solid-state drive (see Mass storage device on page 37)

c. Top cover (see Top cover on page 39)

d. Audio board (see Audio board on page 41)

Remove the Bluetooth module:

1. Detach the Bluetooth module (1) from the system board.

NOTE: The Bluetooth module is attached to the system board by double-sided tape.
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2. Disconnect the Bluetooth module cable (2) from the Bluetooth module.

3. Remove the Bluetooth module.

Reverse this procedure to install the Bluetooth module.
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System board
NOTE: All system board spare part kits include an ExpressCard assembly, fan/heat sink, processor,
RTC battery, and replacement thermal material).

Description Spare part number

Equipped with 1.6-GHz processor and only for use with WXGA displays 482277-001

Equipped with 1.2-GHz processor and only for use with WXGA displays 482276-001

Equipped with 1.0-GHz processor and only for use with WXGA displays 482275-001

Equipped with 1.6-GHz processor 500755-001

Equipped with 1.2-GHz processor 398308-001

Equipped with 1.0-GHz processor 500754-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).

5. Remove the following components:

a. Keyboard (see Keyboard on page 33)

b. Hard drive (see Mass storage device on page 37)

c. Top cover (see Top cover on page 39)

d. Audio board (see Audio board on page 41)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● Memory module (see Memory module on page 36)

● WLAN module (see WLAN module on page 49)
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Remove the system board:

1. Disconnect the following cables from the system board:

(1) Display panel cable

(2) Microphone cable

(3) Camera module cable (only on computer models equipped with webcam)

2. Remove the wireless antenna cables from the clips built onto the system board.

3. Remove the seven Torx8 T8M2.0×6.0 screws (1) that secure the system board and the three
system board brackets to the base enclosure.
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4. Remove the following brackets:

(2) Audio/USB connector bracket

(3) ExpressCard assembly bracket

(4) USB/RJ-45 connector bracket

NOTE: The audio/USB connector bracket, ExpressCard assembly bracket, and USB/RJ-45
connector bracket are included in the Bracket Kit, spare part number 482266-001.

5. Flex the right side of the base enclosure (1) until the USB connector and RJ-45 jack (2) are clear
of the base enclosure.

6. Lift the right side of the system board (3), and then swing it up and to the left until it rests upside
down on the left side of the computer.
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7. Disconnect the WLAN antenna cables from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

8. Remove the system board.

Reverse the preceding procedure to install the system board.
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WLAN module

Description Spare part number

Broadcom 4311AG 802.11a/b/g WLAN modules:

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

441075-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-002

● For use in Japan 441075-291

Broadcom BCM4312 802.11b/g WLAN modules:

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

459263-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,

459263-002
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Description Spare part number

the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).

5. Remove the following components:

a. Keyboard (see Keyboard on page 33)

b. Hard drive or solid-state drive (see Mass storage device on page 37)

c. Top cover (see Top cover on page 39)

d. Audio board (see Audio board on page 41)

e. System board (see System board on page 45)

Remove the WLAN module:

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore computer functionality, and then contact technical support through Help and Support.

1. Turn the system board upside down, with the front toward you.

2. Remove the Torx8 T8M2.5×5.0 screw (1) that secures the WLAN module to the system board.
(The edge of the module opposite the slot rises away from the computer.)
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3. Remove the WLAN module (2) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (3) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).

5. Remove the following components:

a. Keyboard (see Keyboard on page 33)

b. Hard drive or solid-state drive (see Mass storage device on page 37)

c. Top cover (see Top cover on page 39)

d. Audio board (see Audio board on page 41)

e. System board (see System board on page 45)

Remove the RTC battery:

1. Turn the system board upside down, with the front toward you.

2. Disconnect the RTC battery cable (1) from the system board.
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3. Detach the RTC battery (2) from the system board.

NOTE: The RTC battery is attached to the system board with double-sided tape.

4. Remove the RTC battery.

Reverse this procedure to install the RTC battery.
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Fan/heat sink

Description Spare part number

Fan/heat sink 482279-001

Before removing the fan/heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).

5. Remove the following components:

a. Keyboard (see Keyboard on page 33)

b. Hard drive or solid-state drive (see Mass storage device on page 37)

c. Top cover (see Top cover on page 39)

d. Audio board (see Audio board on page 41)

e. System board (see System board on page 45)

Remove the fan/heat sink:

1. Following the 1, 2, 3, 4, 5 sequence stamped into the fan/heat sink, remove the five Torx8
T8M2.0×6.0 screws (1) that secure the fan/heat sink to the system board
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2. Remove the fan/heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the fan/heat sink
and system board components. Thermal grease is used on the video chip (1) and the surface of
the fan/heat sink (1) that contacts the video chip. Thermal tape is used on the processor (2) and
the surface of the fan/heat sink (2) that contacts the processor. Replacement thermal material is
included with all fan/heat sink and system board spare part kits.

Reverse this procedure to install the fan/heat sink.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side
of the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software requirements. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.
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Display assembly
NOTE: All display assembly spare part kits include 2 microphones, 2 speakers, and 2 WLAN antenna
transceivers and cables.

Description Spare part number

8.9-inch, WXGA display assembly for use only with computer models equipped with camera module 483384-001

8.9-inch, WXGA display assembly for use only with computer models not equipped with camera
module

482278-001

8.9-inch, WSVGA display assembly for use only with computer models equipped with camera
module and system boards with the following spare part numbers: 498308-001, 500754-001, and
500755-001

498309-001

8.9-inch, WSVGA display assembly for use only with computer models not equipped with camera
module and system boards with the following spare part numbers: 498308-001, 500754-001, and
500755-001

502600-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).

5. Remove the following components:

a. Keyboard (see Keyboard on page 33)

b. Hard drive or solid-state drive (see Mass storage device on page 37)

c. Top cover (see Top cover on page 39)

d. Audio board (see Audio board on page 41)

e. System board (see System board on page 45)

6. Disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 49).

Remove the display assembly:

1. Remove the wireless antenna cables (1) from the clips and routing channels built into the base
enclosure.

CAUTION: The display assembly will be unsupported when the following screws are removed.
To prevent damage to the display assembly, support it before removing the screws.

2. Remove the four Torx8 T8M2.5×10.0 screws (2) and the two Torx8 T8M2.5×5.0 screws (3) that
secure the display assembly to the computer.
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3. Lift the display assembly (4) straight up and remove it.

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup:

1. Turn on or restart the computer.

2. Before your operating system opens and while the "F10 = ROM Based Setup" message is displayed
in the lower-left corner of the screen, press f10.
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Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not operating system based, it does not support the TouchPad.
Navigation and selection are by keystroke:

● To choose a menu or a menu item, use the arrow keys.

● To select an item, press enter.

● To close open dialog boxes and return to the main Computer Setup screen, press esc.

● To view navigation information, press f1.

● To change the language, press f2.

2. Select the File, Security, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore changes and exit. Then follow the instructions on the screen.

● To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
changes and exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore defaults, and then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
changes and exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System information ● View identification information for the computer and the batteries in the
system.

● View specification information for the processor, cache and memory size,
system ROM, video revision, and keyboard controller version.

Restore defaults Replace the configuration settings in Computer Setup with the original factory
settings. (Password settings and security settings are not changed when you
restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and restart the
computer.

Save changes and exit Save any changes entered during the current session. Then exit and restart the
computer. Your changes go into effect when the computer restarts.

Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

BIOS Administrator password Enter, change, or delete a setup password.

Change BIOS administrator password Enter, change, or delete a BIOS Administrator password.

Password check ● Enable/disable Always to always check for a password.

● Enable Setup to set the password.

Password Options ● Enable/disable stringent security.

● Enable/disable password requirement on computer restart.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive.

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you enter Computer Setup
by turning on (not restarting) the computer.

Notebook hard drive password status Enable/disable hard drive password status visibility.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Boot Options ● Set an f9 and f10 delay when starting up.

● Set the Express Boot Popup delay in seconds.

● Enable/disable internal network adapter boot and set the boot mode (PXE).

● Enable/disable MultiBoot, which sets a boot order that can include most boot
devices in the system.

● Set the boot order.

◦ 1st boot device: USB devices

◦ 2nd boot device: Notebook hard drive

◦ 3rd boot device: Notebook Ethernet

Device Configurations ● Swap the functions of the fn key and left ctrl key.

● Enable/disable USB legacy support. When enabled, USB legacy support
allows the following:

◦ Use of a USB keyboard in Computer Setup even when your operating
system is not running.

◦ Startup from bootable USB devices, including a hard drive, diskette
drive, or optical drive connected by a USB port to the computer.

● Enable/disable fan always on while connected to an AC outlet.

● Enable/disable SATA Native Mode.

Built-In Device Options ● Enable/disable embedded WLAN Device Radio.

● Enable/disable embedded Bluetooth.

● Enable/disable Wake on LAN.

● Enable/disable Network Interface Controller (LAN)

NOTE: Always set the fan to 40% PWM while this item is enabled.

● Enable/disable integrated camera.

● Enable/disable Wake on LAN.

● Enable/disable the ExpressCard slot.

Computer Setup menus 61



6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Depth 16.51 cm 6.50 in

Width 25.50 cm 10.04 in

Height (front to back) 2.67 to 3.30 cm 1.05 to 1.30 in

Weight

Equipped with a 3-cell battery, 120-GB hard drive, 1-GB
memory, WLAN module, and 2 wireless antennae

1.27 kg 2.80 lbs

Equipped with a 3-cell battery, 4-GB solid-state drive, 1-GB
memory, WLAN module, and 2 wireless antennae

1.19 kg 2.63 lbs

Input power

Operating voltage 18.5 V dc @ 3.5 A – 65 W

Operating current 3.5 A

Temperature

Operating 0°C to 35°C 32°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate
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 Metric U.S.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

8.9-inch, WXGA display specifications
 Metric U.S.

Dimensions

Height 11.7 cm 4.61 in

Width 19.5 cm 7.68 in

Diagonal 22.7 cm 8.94 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1280 × 768

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-40 horizontal, +20/–40° vertical (typical)
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8.9-inch, WSVGA display specifications
 Metric U.S.

Dimensions

Height 11.3 cm 4.45 in

Width 19.5 cm 7.68 in

Diagonal 22.6 cm 8.90 in

Number of colors 6-bit, 262,144

Contrast ratio 300:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.1905 × 0.189 mm

Format 1024 × 600

Configuration RGB vertical stripe

Backlight Integral LED

Total power consumption 3.0 W

Viewing angle +20/-40 horizontal, +40/–40° vertical (typical)
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Hard drive specifications
 160-GB* 120-GB*

Dimensions

Height 9.5 mm 9.5 mm

Width 70 mm 70 mm

Weight 101 g 101 g

Interface type SATA SATA

Transfer rate 100 MB/sec 100 MB/sec

Security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms

Average 13 ms 13 ms

Maximum 24 ms 24 ms

Logical blocks 312,560,640 234,420,480

Disc rotational speed 7200 and 5400 rpm 7200 and 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for ExpressCard

DMA6 Not assigned

DMA7 Not assigned

*ExpressCard controller can use DMA 1, 2, or 5.
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System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: ExpressCards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial
port may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused
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I/O address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 ExpressCard controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)
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System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in
the computer. All screws listed in this section are available in the Screw Kit, spare part number
483383-001.

Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 3 3.0 mm 2.0 mm 4.5 mm

Where used: 3 screws that secure the keyboard to the computer
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Phillips PM2.0×5.0 screw

Color Quantity Length Thread Head diameter

Black 2 5.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the mass storage device to the computer
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Torx8 T8M2.0×6.0 screw

Color Quantity Length Thread Head diameter

Silver 14 6.0 mm 2.0 mm 4.5 mm

Where used: One screw that secures the audio board to the system board

Where used:

(1) Three screws that secure the audio/USB connector bracket to the system board
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(2) Two screws that secure the ExpressCard assembly bracket to the system board

(3) Two screws that secure the USB/RJ-45 connector bracket to the system board

Where used: 5 screws that secure the fan/heat sink to the system board
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Torx8 T8M2.5×5.0 screw

Color Quantity Length Thread Head diameter

Black 4 5.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the mass storage device to the computer
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Where used: One screw that secures the WLAN module to the system board

Where used: 2 screws that secure the display assembly to the base enclosure
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Torx8 T8M2.5×10.0 screw

Color Quantity Length Thread Head diameter

Silver 8 10.0 mm 2.5 mm 5.0 mm

Where used: 3 screws that secure the top cover to the computer

Where used: One screw that secures the top cover to the computer
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Where used: 4 screws that secure the display assembly to the base enclosure

Torx8 T8M2.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 1 4.0 mm 2.0 mm 4.5 mm

Where used: One screw that secures the top cover to the computer
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8 Backup and recovery

Backup and recovery in Windows Vista
Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

Windows® Vista® provides the following advanced backup and recovery options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

Backing up

Backup tips

● Connect the computer to AC power during the backup process.

● Store personal files in the Documents folder and back them up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

To create a backup using Backup and Restore Center, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure, use the f11 recovery tool to recover your original hard drive image. The image
includes the Windows operating system and software programs installed at the factory.

NOTE: Windows Vista provides additional recovery tools through the operating system. For additional
information, go to Help and Support.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Recovering information using a Windows Vista operating system DVD
(purchased separately)” section in this guide.

Recovering the hard drive using f11
CAUTION: Using f11 will completely erase hard drive contents and reformat the hard drive. All files
you have created and any software installed on the computer will be permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.
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To recover the original hard drive image, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

NOTE: If the HP Recovery partition has been deleted, you will need to recover your operating
system and programs using the Windows Vista operating system DVD and the Driver Recovery
disc (purchased separately). For additional information, refer to the “Recovering information using
a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Recovering information using a Windows Vista operating system DVD (purchased
separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system
DVD to reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows Vista operating system
DVD, go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD will completely erase hard drive contents
and reformat the hard drive. All files you have created and any software installed on the computer will
be permanently removed. When reformatting is complete, the recovery process will help you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process will take several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery in Windows XP
Backing up your information

NOTE: You can recover only the files that you have previously backed up. HP recommends that you
use the Windows backup utility to create a hard drive backup as soon as you set up your computer.

With the Windows backup utility, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesirable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

NOTE: The Windows backup utility backs up only data files. The operating system, drivers, and
programs are located on the operating system disc and System Recovery disc that are included with
the computer.

When to backup

● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions

● Connect the computer to external power before performing backup and recovery procedures.

● Create system recovery points.

● Store personal files in the My Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, click Edit > Paste.

The screen image is added to the document.

4. Save the document.
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Backing up individual files or folders
You can back up individual files or folders to an optional external hard drive or to a network drive.

NOTE: This process will take several minutes, depending on the file size and the speed of the
computer.

To back up individual files or folders:

1. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard page opens.

2. Click Next.

3. Click Backup files and settings, and then click Next.

4. Follow the on-screen instructions.

Backing up all files and folders
When you back up all files and folders, you are saving all personal files and folders, all system files, and
configuration settings at one time.

NOTE: When you back up all files and folders, this does not include the operating system or programs.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

NOTE: A copy of the backup files can be stored on an optional external hard drive or on a network
drive.

To back up all files and folders:

1. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard page opens.

2. Click Next.

3. Click Backup files and settings, and then click Next.

4. Click All information on this computer, and then click Next.

5. Follow the on-screen instructions.

Creating recovery points
When you back up system modifications since your last backup, you are creating system recovery
points. This allows you to save a snapshot of your hard drive at a specific point in time. You can then
recover back to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.
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HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > Accessories > System Tools > System Restore.

The System Restore window opens.

2. Click Create a new restore point, and then click Next.

3. Type a short description of the restore point. This will be used as the name of the restore point.

4. Click Create.

5. Follow the on-screen instructions.

Scheduling backups
You can schedule backups for the entire system, for recovery points, or for specific files and folders.
Backups can be scheduled at specific intervals (daily, weekly, or monthly) or at specific events, such as
at system restart or when you log on.

To schedule backups:

1. Select Start > All Programs > Accessories > System Tools > Schedule Tasks.

The Schedule Tasks window opens.

2. Double-click Add Scheduled Task, and then click Next.

3. Select Backup in the Application list, and then click Next.

4. Type a name for the backup, select when you want the backup to be performed, and then click
Next.

5. Enter your user name, password, and password again to confirm. Click Next, and then click
Finish.

Performing a recovery
The Windows backup utility helps you recover important files that you have previously backed up in
case of system failure.

NOTE: To recover the operating system and programs, use the operating system disc and System
Restore disc that are included with the computer.
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Initiating a recovery in Windows

To initiate a recovery in Windows, follow these steps:

1. If possible, back up all personal files.

2. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard page opens.

3. Click Restore files and settings, and the click Next.

4. Follow the on-screen instructions.

Backup and recovery in SUSE Linux Enterprise Desktop
Performing a recovery

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The f11 recovery
tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. Press f11 while the "Press <F11> for recovery" message is displayed on the screen.

3. Follow the on-screen instructions.
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9 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock

External monitor 87



RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused

Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
Careful handling must be exercised when removing these components. When you remove these
components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from
one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.

96 Chapter 11   Recycling



Index

A
AC adapter, spare part

number 19,  21
antenna

disconnecting 48
locations 4

audio board
removal 41
spare part number 15,  22, 

23,  41
audio, product description 2
audio-in jack

location 9
pin assignments 86

audio-out jack
location 9
pin assignments 86

audio/USB connector bracket
illustrated 18
removal 47

B
backing up 79
backup tips 79
base enclosure, spare part

number 17,  21
battery

location 10
removal 32
spare part numbers 17,  21, 

32
battery bay 10
battery latches 10
battery light 8
Bluetooth module

removal 43
spare part numbers 15,  20, 

21,  43
Bluetooth module cable 19
boot options 61

boot order 61
bottom components 10
Bracket Kit

contents 18
spare part number 15,  18, 

22
buttons, TouchPad 6

C
cables, service considerations 25
chipset, product description 1
CMOS clearing 29
components

bottom 10
front 7
keys 5
left-side 9
pointing devices 6
right-side 8
top 4
TouchPad 6

computer feet
locations 31
spare part number 31

Computer Setup
accessing 58
File menu 60
navigating and selecting 59
restoring factory settings 59
Security menu 60
System Configuration

menu 61
using 59

computer specifications 62
connectors

power 8
service considerations 25

D
diskette drive

precautions 25
product description 2

display assembly
removal 56
spare part numbers 13,  22, 

23,  56
display component recycling 91
display specifications 63
drive light 7
DriveLock password 60
drives

boot order 61
preventing damage 25

E
electrostatic discharge 26
esc key 5
Ethernet, product description 2
ExpressCard assembly bracket

illustrated 18
removal 47

ExpressCard slot 8
ExpressCard slot bezel 19
external media cards, product

description 2
external monitor port

location 9
pin assignments 87

F
f11 recovery 80
fan/heat sink

removal 54
spare part number 15,  22, 

54
feet

locations 31
spare part number 31

Index 97



File menu 60
flash storage drive, product

description 1
fn key 5
front components 7
function keys 5

G
graphics, product description 1
grounding equipment and

methods 28

H
hard drive

precautions 25
product description 1
removal 37
spare part numbers 15,  22, 

37
specifications 65

hard drive recovery 80
headphone jack

location 9
pin assignments 86

I
I/O address specifications 68
individual file recovery 79
interrupt specifications 67

J
jacks

audio-in 9
audio-out 9
headphone 9
microphone 9
network 8
RJ-45 8

K
key components 5
keyboard

product description 2
removal 33
spare part numbers 14,  22, 

33
keypad keys 5
keys

esc 5
fn 5
function 5

keypad 5
Windows applications 5
Windows logo 5

L
left-side components 9
legacy support, Universal Serial

Bus (USB) 58,  61
lights

battery 8
drive 7
power 7
wireless 7

M
mass storage device

product description 1
removal 37
spare part numbers 15,  37

memory map specifications 70
memory module

product description 1
removal 36
spare part numbers 15,  20, 

36
microphone jack

location 9
pin assignments 86

microphones 4
model name 1
modem, product description 2
monitor port

location 9
pin assignments 87

N
navigating in Computer Setup 59
network jack

location 8
pin assignments 88

O
operating system, product

description 3
optical drive, product

description 2

P
packing guidelines 27
panels, product description 1
password clearing 29

passwords 60
pin assignments

audio-in jack 86
audio-out jack 86
external monitor port 87
headphone jack 86
microphone jack 86
monitor port 87
network jack 88
RJ-45 jack 88
Universal Serial Bus (USB)

port 88
plastic parts 24
Plastics/Cable Kit

contents 19
spare part number 15,  19, 

23
pointing device

components 6
illustrated 6

pointing device components
TouchPad 6
TouchPad buttons 6
TouchPad on/off button 6
TouchPad scroll zone 6

pointing devices, product
description 2

ports
external monitor 9
monitor 9
power USB 9
product description 2
Universal Serial Bus (USB) 8
USB 9

power connector 8
power cord

set requirements 89
spare part numbers 19,  20

power light 7
power requirements, product

description 3
power switch 7
powered USB port 9
processor, product description 1
product description

audio 2
chipset 1
diskette drive 2
Ethernet 2
external media cards 2

98 Index



flash storage drive 1
graphics 1
hard drive 1
keyboard 2
mass storage devices 1
memory module 1
modem 2
operating system 3
optical drive 2
panels 1
pointing devices 2
ports 2
power requirements 3
processors 1
product name 1
security 3
serviceability 3
solid-state drive 1
webcam 2
wireless 2

product name 1

R
recovery 80
recovery partition 79
removal/replacement

preliminaries 24
procedures 30

restoring Computer Setup factory
settings 59

right-side components 8
RJ-45 jack

location 8
pin assignments 88

RTC battery
removal 52
spare part number 16,  21, 

52
Rubber Kit, spare part number 23

S
Screw Kit

contents 71
spare part number 20,  23

screw listing 71
SD Card Reader 8
SD Card slot bezel 19
security cable slot 8
Security menu 60
security, product description 3

selecting in Computer Setup 59
serial number 12,  30
service considerations 24
service tag 10
serviceability, product

description 3
solid-state drive

product description 1
removal 37
spare part number 15,  22, 

23,  37
speakers 4
specifications

computer 62
display 63
hard drive 65
I/O addresses 68
interrupts 67
memory map 70
system DMA 66

static-shielding materials 28
stringent security 60
switches

power 7
wireless 7

system board
removal 45
spare part numbers 15,  22, 

23,  45
System Configuration menu 61
system DMA 66
system failure or instability 79
system fan 61
system information 60
system memory map 70
system restore points 79

T
thermal material, replacement 55
tools required 24
top components 4
top cover

removal 39
spare part number 15,  21, 

39
TouchPad 6
TouchPad buttons 6
TouchPad components 6
TouchPad on/off button 6
TouchPad scroll zone 6

transporting guidelines 27

U
Universal Serial Bus (USB) legacy

support 58,  61
unknown password 29
USB port

location 8
pin assignments 88

USB/RJ-45 connector bracket
illustrated 18
removal 47

V
vents 9,  10

W
webcam 4
webcam, product description 2
Windows applications key 5
Windows logo key 5
wireless antenna

disconnecting 48
locations 4

wireless light 7
wireless switch 7
wireless, product description 2
WLAN module

removal 49
spare part numbers 16,  20, 

21,  49
workstation guidelines 27

Index 99




	Product description
	External component identification
	Top components
	Display
	Keys
	TouchPad

	Front components
	Right-side components
	Left-side components
	Bottom components
	Wireless antennae (select models only)

	Illustrated parts catalog
	Serial number location
	Computer major components
	Bracket Kit
	Plastics/Cable Kit
	Miscellaneous parts
	Sequential part number listing

	Removal and replacement procedures
	Preliminary replacement requirements
	Tools required
	Service considerations
	Plastic parts
	Cables and connectors
	Drive handling

	Grounding guidelines
	Electrostatic discharge damage
	Packaging and transporting guidelines
	Workstation guidelines
	Equipment guidelines


	Unknown user password

	Component replacement procedures
	Serial number
	Computer feet
	Battery
	Keyboard
	Memory module
	Mass storage device
	Top cover
	Audio board
	Bluetooth module
	System board
	WLAN module
	RTC battery
	Fan/heat sink
	Display assembly


	Computer Setup
	Starting Computer Setup
	Using Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup

	Computer Setup menus
	File menu
	Security menu
	System Configuration menu


	Specifications
	Computer specifications
	8.9-inch, WXGA display specifications
	8.9-inch, WSVGA display specifications
	Hard drive specifications
	System DMA specifications
	System interrupt specifications
	System I/O address specifications
	System memory map specifications

	Screw listing
	Phillips PM2.0×3.0 screw
	Phillips PM2.0×5.0 screw
	Torx8 T8M2.0×6.0 screw
	Torx8 T8M2.5×5.0 screw
	Torx8 T8M2.5×10.0 screw
	Torx8 T8M2.0×4.0 screw

	Backup and recovery
	Backup and recovery in Windows Vista
	Overview
	Backing up
	Backup tips
	Backing up your information

	Performing a recovery
	Recovering the hard drive using f11
	Recovering information using a Windows Vista operating system DVD (purchased separately)


	Backup and recovery in Windows XP
	Backing up your information
	When to backup
	Backup suggestions
	Backing up individual files or folders
	Backing up all files and folders
	Creating recovery points
	Scheduling backups
	Performing a recovery
	Initiating a recovery in Windows



	Backup and recovery in SUSE Linux Enterprise Desktop
	Performing a recovery


	Connector pin assignments
	Audio-out (headphone)
	Audio-in (microphone)
	External monitor
	RJ-45 (network)
	Universal Serial Bus

	Power cord set requirements
	Requirements for all countries and regions
	Requirements for specific countries and regions

	Recycling
	Battery
	Display

	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.3
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages false
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 524288
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings false
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Remove
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
    /Courier
    /Courier-Bold
    /Courier-BoldOblique
    /Courier-Oblique
    /Helvetica
    /Helvetica-Bold
    /Helvetica-BoldOblique
    /Helvetica-Oblique
    /Symbol
    /Times-Bold
    /Times-BoldItalic
    /Times-Italic
    /Times-Roman
    /ZapfDingbats
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 150
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.00000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 150
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.00000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 600
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.33333
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /SyntheticBoldness 1.000000
  /Description <<
    /ENU <FEFF0046004f00520020004100630072006f006200610074002000360020004f004e004c0059000d0048005000490045002000530063007200650065006e0020004f007000740069006d0069007a00650064002000530065007400740069006e006700200066006f00720020004100630072006f006200610074002000360020004f004e004c0059>
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [612.000 792.000]
>> setpagedevice


